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MODELO HIDROLÓGICO SEMIDISTRIBUIDO 

1 INTRODUCCIÓN 

En la actualidad, la presión sobre la sustentabilidad de los recursos naturales está en aumento,  

debido al crecimiento exponencial de la población mundial, acrecentando la demanda por los 

alimentos y explotación de los recursos suelo y agua (Xu y Singh, 2004). A este escenario se suma los 

potenciales impactos del cambio climático a nivel global. En el tercer informe del Panel Inter 

gubernamental para el Cambio Climático indica que existe una variación en la temperatura y la 

precipitación, produciendo cambios en la disponibilidad del agua a nivel de cuenca (IPCC, 2001). 

Muchas de las comunidades andinas de Bolivia dependen en gran medida de los recursos hídricos 
generados en cuencas de alta montañas. Una limitante para el entendimiento de la oferta de recursos 
hídricos en cuencas de alta montaña es la escasa información de variables hidro climáticas, de ahí la 
importancia del uso de diferentes técnicas y modelos que permitan representar con suficiente 
precisión dicha información y posteriormente extrapolar su desempeño a cuencas con similares 
características hidrológicas y fisiográficas. 

En este documento se presentan los resultados obtenidos en la modelación hidrológica superficial  de 
la cuenca correspondiente al Río Sajama localizada en el departamento de Oruro. Respondiendo al 
indicador siete de la propuesta técnica, presentada en mayo 2013, cuyo objetivo principal  es 
“Estudiar la oferta de agua superficial e inferir potenciales impactos del cambio climático (en la oferta 
de agua superficial), en una región del Parque Nacional Sajama” corresponde al Proyecto:” Los 
bofedales como un aliado en la resiliencia y mitigación del cambio climático". Referencias al Proyecto 
así como sus antecedentes se detallan en los Términos de Referencia (TDR) y Propuesta Técnica. El 
presente documento se desarrolla basado en los TDR mencionados y al correspondiente Contrato 
Civil por Servicios de Consultoría. 

La presente pasantía es llevada a cabo por solicitud de Agua Sustentable. Durante el desarrollo del 

mismo, se agradece la participación del Ingeniero Freddy Soria por la colaboración en la revisión 

literaria, guía en el procesamiento y análisis de la base de datos. También se agradece el valioso 

apoyo del personal técnico de agua sustentable en la recolección de datos de campo. 

2 PROCESOS Y HERRAMIENTAS UTILIZADAS 

2.1 Área de estudio 

El área de estudio comprende la cuenca del río Sajama, que es parte del Parque Nacional Sajama 

(PNS). Se encuentra entre los 17°55’ - 18°15’ de latitud sur y 68°40’- 69°10’ de longitud oeste, en un 

rango altitudinal de 4102 a 6436. La cuenca del río Sajama cuenta con un área total de 557,36 km2 

(Figura 1). La zona presenta siete meses del año secos, temperaturas mínimas medias bajo cero a lo 

largo de todo el año, así como todos los meses con heladas nocturnas, Estos factores, así como la 

amplitud térmica diaria (19,1°C) limitan el desarrollo de la agricultura en la zona, por lo que la 

actividad económica principal radica en la crianza de camélidos (Liberman 1986 y García 2012, citado 

por Lorini 2012). 
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Figura 1. Ubicación de la cuenca en estudio. 

 

2.2 Estructura del modelo matemático semidistribuido de balance hídrico superficial 

A diferencia de cuencas de climas templados con morfología homogénea, el modelo matemático semi 

distribuido de balance hídrico superficial, está desarrollado para cuencas hidrográficas de alta 

montaña que presentan una morfología relativamente heterogénea como es la cuenca del río Sajama.  

Al final de la temporada seca las cuencas hidrográficas dependen de la cantidad total de lluvia 

efectiva (precipitación menos evapotranspiración potencial) y en el inicio de la temporada de lluvias, 

la mayor parte de la precipitación se infiltra y muy poca escorrentía es producida. En la temporada de 

lluvia como sucesivamente la precipitación es más frecuente, los poros y micro poros de la estructura 

del suelo se llenan de agua hasta llegar a su capacidad máxima de retención de agua, produciendo la 

escorrentía y percolación. Cada zona de la cuenca tiene diferente capacidad de retención de agua por 

lo que contribuye a la recarga del río principal de la cuenca, con un cierto volumen, en diferente 

momento. 



 

 

ESTUDIO DE RELACIONES PRECIPITACIÓN-ESCURRIMIENTO Y DE POTENCIALES EFECTOS DEL CAMBIO CLIMÁTICO EN LA OFERTA DE 
AGUA DE LA CUENCA DE LOS RÍOS SURURÍA, MILLUNI Y RÍO SAJAMA (CARIPE-MILLUNI), EN EL PARQUE NACIONAL SAJAMA-BOLIVIA 

MODELO HIDROLÓGICO SEMIDISTRIBUIDO 
2013 

3 

El modelo semidistribuido de balance hídrico superficial mencionado, se basa en el trabajo de Collick 

et al. (2009), bajo el principio de que las diferentes partes de la cuenca contribuyen con escorrentía a 

la corriente en diferentes momentos. Para definir las zonas tributarias, la cuenca se sub divide en 

zonas, donde cada una cuenta con un esquema que describe el balance hídrico de manera 

independiente. Cada región o zona de la cuenca empieza a contribuir a la recarga de agua, mediante 

aportes de aguas subterráneas (acuíferos profundos), flujo lateral y escorrentía superficial cuando el 

suelo alcanza un contenido de humedad umbral denominado Tmax (Collick et al. 2009). A diferencia de 

Soria (2012), la estructura tiene un esquema discretizado de manera diferente. 

En los siguientes sub títulos se describen conceptos y estructura del modelo Hidrológico 

semidistribuido de Collick et al. (2009). 

a) Modelo de balance hídrico Superficial 

El esquema general para el modelo de balance hídrico superficial, está basado en la expresión 

general del balance de humedad en el suelo (Ojha y Singh 2002, citado por Soria, 2012). 

 

b) Balance de humedad del suelo 

El modelo estima el volumen de almacenamiento de agua por unidad de área S(L), utilizando 

la precipitación P(L/T), la evapotranspiración real AET(L/T), escorrentía superficial R(L/T), 

percolación profunda Perc (L/T), y el tiempo de almacenamiento anterior St-Δt (T). La ecuación 

para el balance de humedad del suelo para un intervalo de tiempo Δt es el que sigue (Collick 

et al. 2009): 

�� = ���∆� + �� − 
�� −  − �����∆�   (1). 

Ojha y Singh (2002) citado por Soria (2012), resume la anterior ecuación en: 

)(/ QAETPdtdS −−=                  (2). 

Donde el volumen de almacenamiento de agua por unidad de área S (L) durante un paso de 

tiempo t, está determinado por la precipitación P (L/T), la evapotranspiración actual o real 

AET (L/T) y el escurrimiento total de la cuenca Q (L/ T) que es la contribución de la recarga de 

agua mediante la percolación profunda Perc  y el escurrimiento superficial R. 

 Se debe considerar que  el escurrimiento superficial R es inexistente bajo condiciones áridas 

o suelos con alta tasa se infiltración y Perc, el cual se determina a través del coeficiente de 

escorrentia Cse (Soria, 2012). 

c) Evapotranspiración real AET 

La ecuación para el cálculo de la evapotranspiración real AET, es la siguiente (Collick et al. 

2009): 
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�� = ��� � �������						                                     (3). 

 

Donde la evapotranspiración actual AET, está determinado por la evapotranspiración 

potencial PET, el volumen de almacenamiento St y la capacidad de almacenamiento de 

humedad en el suelo por unidad de área Tmax(L). 

 

Durante la época de lluvias, cuando las precipitaciones superan la evapotranspiración (P> 

PET) o el contenido de humedad está por encima de la capacidad de campo, la humedad de 

almacenamiento St, se determina a partir de la adición de la humedad del día anterior St-Δt(L) 

a la diferencia entre P y PET, durante el paso de tiempo. En la época seca, cuando la 

evaporación excede la precipitación (P <PET) y el contenido de humedad del suelo está por 

debajo de la capacidad de campo, la evapotranspiración real AET (L/T) disminuye linealmente 

a partir de la tasa potencial en capacidad de campo a cero en el punto de marchitez 

(Thornthwaite y Mather 1955, citado por Collick et al. 2009). 

 

Cuando la evaporación excede la precipitación (P <PET), la humedad de almacenamiento 

durante un paso de tiempo t puede escribirse como una función exponencial (Lyon et al. 

2004, citado por Collick et al, 2009): 

 

�� = ���∆� ���� ����� ��∆����� �!   (4). 

 

Cuando la lluvia excede la evaporación (P> PET), se añade la precipitación neta al 

almacenamiento del día anterior (Collick et al. 2009). 

 �� = ���∆� + �� − ����∆�    (5). 

 

d) Contribución de la percolación y escorrentía superficial 

Cuando la precipitación satura completamente el suelo, el agua en exceso Exm (L/T) se 

convierte en escorrentía superficial o se filtra a los acuíferos (percolación profunda). 

Considerando que la humedad existente en el suelo St es igual que la capacidad de 

almacenamiento de agua en el suelo Tmax (ecuación 7), el exceso de agua después de la 

saturación del suelo se puede determinar mediante la siguiente ecuación modificada de la 

ecuación original presentada en Collick et al. (2009): 

 

 ��" = ����∆� + � − ���� − �"#$	               (6). �� = �"#$              (7). 

 

Por encima del valor umbral Tmax el exceso de humedad se divide entre percolación y 

escorrentía (Collick et al. 2009). 
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���� = %��"                       (8).  = �1 − %���"      (9). 

 

Donde β es el coeficiente de escorrentía utilizado como un parámetro de calibración. La 

percolación contribuye a un deposito de flujo base RS (L/P), en un paso de tiempo (Easton et 

al. 2007, citado por Collick et al. 2009). 

 �� = ���∆� + ������ − '(��∆��∆�                    (10). 

 

Donde BFt es la cantidad modelado de flujo base (L/T) y se calcula usando un modelo de 

yacimiento lineal siguiente: 

 

'(� = �� )*�+$,��#∆��-∆�     (11). 

 

Donde . (1/T) es el coeficiente de recesión, una propiedad del acuífero y puede ser calibrado 

del flujo base de la curva de recesión y ∆� es el paso del tiempo (Easton et al. 2007, citado por 

Collick et al. 2009). 

2.3 Delimitación y división de la cuenca en zonas 

La delimitación de la cuenca se realizo mediante el programa ArcGis 9.3, que cuenta con 

herramientas hidrológicas que permiten modelar el flujo de agua a través de una superficie de un 

Modelo de Elevación Digital (DEM). Para delimitar automáticamente una cuenca hidrográfica y 

construir la red hídrica a partir de un DEM con la ayuda del programa ArcGis, se realizó el siguiente 

procedimiento: 

a) Obtención y proyección del DEM 

El DEM utilizado se obtuvo de la base de datos de Agua Sustentable, cuenta con pixeles de  

30x30m. El archivo raster no contaba con una proyección por lo que por medio de la caja de 

herramientas Arc Toolbox, se definió la proyección al sistema de coordenadas UTM WGS 

1984 (ArcToolbox > Data Management Tools > Projections and Transformations > Raster > 

Project Raster). 

 

b) Eliminar imperfecciones del DEM 

Una vez definida la proyección se uso la herramienta Fill, que permite rellenar vacios en la 

superficie del raster para quitar imperfecciones en la información del DEM (ArcToolbox > 

Spatial Analyst Tools > Hydrology > Fill). 

 

c) Definir la dirección de la red hídrica 

Por medio de la herramienta Flow Direction, se creó un raster con la dirección de flujo de 

cada una de sus celdas, para el cual se uso el DEM sin imperfecciones, para definir la dirección 

de la red hídrica (ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Direction). 
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d) Determinar la acumulación de la red hídrica 

El programa simula el curso de una gota de agua desde la parte más alta de la cuenca hasta la 

parte en que se va acumulando, mediante la herramienta Flow Acumulation que crea un 

ráster del flujo acumulado para cada una de sus celdas. La entrada de esta herramienta es el 

archivo ráster generado con la herramienta Flow Direction (ArcToolbox > Spatial Analyst Tools 

> Hydrology > Flow Accumulation).  

 

e) Delimitación automática de la cuenca 

Para delimitar la cuenca hidrográfica se apoyo en la herramienta Basin, que elabora un ráster 

delineando la cuenca en base al ráster creado con la herramienta Flow Direction (ArcToolbox 

> Spatial Analyst Tools > Hydrology > Basin). 

Con la herramienta Raster to Poligono se transformo el raster obtenido en el proceso anterior 

a shapefile (ArcToolbox > Conversion Tools > From Raster > Raster to Polygon). 

 

Para el uso del modelo hidrológico semidistribuido de balance de humedad en el suelo, se dividió  la 

cuenca en cuatro zonas tributarias (figura 2). Estas zonas se identificaron a partir del porcentaje de 

vegetación existente, altitud, el porcentaje de pendiente, textura del suelo y otras características 

como la presencia de nieve acumulada en la superficie. La división de la cuenca en formato digital se 

realizó mediante el programa ArcGis 9.3., a través de la superficie de un Modelo de Elevación Digital 

(DEM) y un ráster de Índice de Vegetación de Diferencia Normalizada (NDVI), el último muestra la 

cantidad y calidad de cubierta vegetal en la superficie de la cuenca. Otro de los parámetros de 

entrada para el modelo hidrológico es el área de cada zona tributria identificada, esta información se 

muestra en el cuadro 1. 
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Figura 2. División en zonas de la cuenca del río Sajama. 

 

Cuadro 1. Superficies de cada zona tributaria de la cuenca. 
 

 

 

 

 

2.4 Parámetros y principales entradas del modelo 

La precipitación y la evapotranspiración son los principales datos de entrada para el modelado 

hidrológico de la cuenca. La cuenca en estudio fue dividido en una serie de aéreas, donde cada área 

tiene su propia Tmax (mm/mes) o capacidad máxima de almacenamiento de agua en el suelo. Este 

almacenamiento debe ser llenado antes de crearse la escorrentía superficial. El modelo es sensible a 

los datos de  precipitación, ETP (evapotranspiración potencial) y a parámetros como el coeficiente de 

escorrentía y el coeficiente de recesión. Los datos de precipitación y otros insumos usados en el 

modelo se describen en las siguientes secciones. 

a) Precipitación y ETP 

Los datos de la variables hidrológicas consideradas en el modelo provienen de tres estaciones 

meteorologicas. Los datos fueron utilizados en función a la altura que corresponde a cada zona: 

Chungara Ajata correspondiente a la zona altas y nevados; Estacion Comisario perteneciente a la zona 

COD Zona 

Alturas 
(msnm) Área m

2 
Área km

2 

min max 

1 Nevados 5020 6436 58512891,29 58,51 

2 Alta 4460 5020 236576237,41 236,58 

3 Media 4320 4460 94326982,83 94,33 

4 Baja 4102 4320 167945733,95 167,95 
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media y la Estación Sajama abarca la zona baja. Las fechas disponibles de los datos de cada estación 

se  muestran en el cuadro 2. 

Cuadro 2. Estaciones meteorológicas usadas para el estudio. 

COD Zona 
Alturas (msnm) Estaciones 

fechas disponibles 
(datos-estaciones) 

min max nombre altura De a 

1 Nevados 5020 6436 Chungara 4585 ene-05 dic-11 

2 Alta 4460 5020 Chungara 4585 ene-05 dic-11 

3 Media 4320 4460 Comisario 4379 nov-11 may-13 

4 Baja 4102 4320 Sajama 4255 ene-05 jun-11 

 

La información de variable climaticas en la mayoria de las estaciones es discontínua. En el caso de las 

estaciones meteorológicas de Chungara Ajata y Sajama, la disponibilidad de datos es escasa a partir 

de diciembre de 2011 y junio de 2011, debido a la ausencia de operador y a la aparente perdida de 

datos para el caso de Sajama, por lo que ha sido necesario homogenizar la información a través del 

relleno y extensión de los registros. 

Para rellenar los datos faltantes de precipitación y evapotranspiración potencial (ETP) se empleó el 

metodo de regresión lineal, debido a que el número de estaciones con información relevante es muy 

reducido. La regresión calcula las estadísticas de una línea utilizando el método de los "mínimos 

cuadrados". Calcula la línea recta que mejor se ajuste a los datos, a continuación devuelve una matriz 

que describe la línea. La ecuación de la regresión lineal es como sigue: 

/ = 0� + 1    (12). 

Donde los valores “y” son dependientes y estan en función de los valores “x” independientes. Los 

valores “m” son coeficientes que corresponden a cada valor “x”, y “b” es un valor constante. 

Como se puede observar en la Figura 3, el coeficiente de correlación existente entre las estaciones de 

Chungara Ajata y Estación Sajama es de 0,89 que esta en un rango aceptable, por lo que se opto a 

realizar el relleno y ampliación de los registros de las variables de precipitación desde enero de 2005 

a marzo de 2013. En el anexo 1 se muestra el resumen de la informacion de precipitación mensual 

consistente, completada y extendida de las respectivas estaciones para el año promedio historico. En 

estas series se aprecia el comportamieto multianual de las precipitaciones pluviales en la zona, que 

presentan una marcada estacionalidad durante el año. 
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Figura 3. Analisis de la correlación entre los datos de precipitación de la estación Chungara Ajata y la 

estación Sajama. 

 

Para la estación meteorológica de Chungara y la Estación Meteorológica Sajama, en la correlación de 

la evapotranspiración potencial se obtuvo un coeficiente de correlación de 0,52 como se puede 

apreciar en la figura 4. Este valor esta dentro del rango calificado como aceptable, considerando la 

muy limitada información disponible. Bajo esta consideración, se completaron y extendieron los 

registros de evapotranspiración desde enero de 2005 hasta marzo de 2013. 

Figura 4. Analisis de la correlación entre los datos de evapotranspiración potencial de la Estación 

Chungara Ajata y Estación Sajama. 

 

La precipitación como variable climática, esta influenciada por los parametros geograficos altitud, 

latitud y longitud. La influencia de los parametros geograficos de superficie (latitud y longitud) en la 

cordillera occidental se hace poco relevante, considerando ademas que las variaciones de la 

precipitación respecto a la línea septentrional y meridional está distorsionada por la presencia de la 
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cadena de montañas andinas; por esta razón se ha considerado únicamente la altitud como 

parámetro relevante para la precipitación (Segura, 2010). 

La estación meteorológica Comisario, es relativamente nueva y cuenta con datos de variables 

climáticas desde noviembre de 2011 a marzo de 2013. La correlación de la gradiente precipitación-

altitud, nos permitio ver el comportamiento y distribución de estas variable a nivel espacial. Mediante 

la ecuación de regresión lineal y expresiones algebraicas simples, se generaron datos que sirvieron de 

entrada al modelo hidrológico semidistribuido de balance de humedad en el suelo, para la 

modelación de la cuenca del río Sajama.  

El cálculo de precipitaciones mensuales correspondientes al periodo enero de 2005 a octubre de 2011 

para el área de influencia cercana a la estación meteorológica Comisario, se realizó a partir de la 

ecuación de regresión lineal obtenida en la correlación entre precipitación – altitud, de las estaciones 

meteorológicas Chungara y Sajama. A partir de ello se determinó que a una altitud de 4379 msnm., 

precipita anualmente 333,26 mm/m2 de agua (aproximadamente), como se muestra en el cuadro 3. 

Mediante esta relación se generaron los datos faltantes desde enero de 2005, presentados en el 

anexo 1. 

Cuadro 3. Parámetros de la gradiente precipitación-altitud. 

  
Precipitación Evapotranspiración Potencial 

  Altitud (msnm) P (mm/año) a b ETP (mm/año) a b 

Chungará 4585 366,75 

0,16 -363,08 

1163,70 

0,3521 -450,53 Sajama 4255 323,74 1047,51 

Comisario 4379 333,26 1090,91 

b) Coeficiente de escorrentia “β” 

Del agua de lluvia que cae sobre la superficie de un terreno, una parte se evapora, otra discurre por la 

superficie (escorrentía) y otra penetra en el suelo (infiltración o percolación). El coeficiente de 

escorrentía depende de numerosos factores: del tipo de precipitación (lluvia, nieve o granizo), de su 

cantidad, de su intensidad y distribución en el tiempo; de la humedad inicial del suelo; del tipo de 

terreno (granulometría, textura, estructura, materia orgánica, grado de compactación, pendiente, 

etc); del tipo de cobertura vegetal existente (Martínez, 2006). 

 

Lo mencionado anteriormente hace que el cálculo de este parámetro sea complejo, para su cálculo 

los diferentes métodos utilizados, en su mayoria son de naturaleza empirica y difieren tanto en su 

fiabilidad como en su complejidad (Ibáñez et. al.,2010). Este parametro puede ser calibrado en 

función a diferentes factores, por lo que para el estudio se considero la ecuación de Nadal citada en 

Martínez (2006): 

 

C = 0.25 k1 k2 k3    (13). 
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Donde K1 es una constante que va en función a la extención de la cuenca, K2 constante que considera 

la precipitación media anual y K3 coeficiente que considera la topografia de la cuenca. Los valores 

que llegan a obtener estas constantes se muestran en el cuadro 4. 

 

Cuadro 4. Valores de los coeficientes correspondiente a la ecuacion de Nadal. 

 

Tabla de Nadal  

Extensión Lluvia media  
Cuenca 

cuenca anual  

km 2 k1 mm k2 características    k3 

10 2,6 200 0,25 llana y permeable 0.5-
0.7 

20 2,45 300 0,5 ondulada   0.7-
1.2 

40 2,15 400 0,75 montañosa e 
impermeable 

1.2-
1.5 

100 1,8 500 1         

200 1,7 600 1,1         

500 1,4 700 1,17         

1000 1,3 800 1,25         

5000 1 900 1,32         

10000 0,9 1000 1,4         

20000 0,87 1200 1,5         

 

 

c) Coeficiente de recesión “a” 

 

El coeficiente de recesión es un parametro que define las fluctuaciones del caudal permanete que 

corre a través de acuiferos debajo de la superficie del suelo. Este parámetro se puede calcular a partir 

de la curva de recesión, los valores obtenidos se presentan a continuación. 
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Cuadro 5. Valores del coeficiente de recesión obtenidos mediante la curva de caudales medidos. 

Mes/año Caudal Medido (m
3
/s) 

a (coeficiente de 
recesión) 

jul-12 2,075 0,161 

ago-12 1,594 0,209 

sep-12 1,429 0,181 

oct-12 1,390 0,328 

nov-12 1,282 0,915 

dic-12 2,197 0,990 

ene-13 3,187 0,309 

feb-13 2,878 0,900 

mar-13 1,625 0,226 

abr-13 1,399 0,301 

may-13 1,700 0,098 

jun-13 1,602 0,113 

jul-13 1,715 0,161 

ago-13 1,554 0,209 

sep-13 1,345 0,181 

 

2.5 Parámetros de ajuste y calibración del modelo 

La calibración de modelos hidrológicos consiste en un proceso de ensayo y error, en el que se cambia 

el valor de uno o varios parámetros utilizados en el cálculo de las variables hidrológicas, con el fin de 

ajustar los datos de salida del modelo a los observados en campo (Eterovic, 2008). Para realizar la 

calibración se debe escoger un periodo de tiempo en el que se tenga buena información de 

precipitación y su correspondiente registro de caudales a la salida de la cuenca (Cots , 2011).  

Mediante la calibración se pretende minimizar la diferencia entre los caudales registrados 

(observados) y los calculados (simulados), optimizando el ajuste a nivel de caudales medios 

mensuales. Para evaluar el ajuste se utiliza diferentes índices de ajuste para la calibración del modelo 

hidrológico. Alanoca (2013) realiza una recopilación breve que se comenta a continuación: 

a) Coeficiente de calibración (r) 

Expresa la dependencia lineal entre los caudales observados y los caudales simulados. La 

ecuación se muestra en la tabla 1. 

b) Criterio de Schultz (D) 

Representa la desviación de los caudales simulados respecto de los observados, que es 

recomendado para análisis de eventos de alta resolución temporal. La ecuación 

correspondiente se presenta en la tabla 1. 

c) Desviación media acumulada (MAD) 

Representa la desviación media de los caudales simulados respecto de los observados en 

forma de error (ecuación en la tabla 1). 
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d) Eficiencia de Nash-Sutcliffe (E) 

Este coeficiente de eficiencia es el más utilizado en hidrología y se define mediante la 

ecuación especificada en la tabla 1, con valores iguales a 1 muestra un mejor ajuste. 

e) Error de balance de masas (m) 

Expresa en porcentaje la relación entre el volumen del hidrograma observado y el 

simulado (ecuación en la tabla 1). Este índice es adecuado para el análisis a nivel mensual 

y anual. 

f) Raíz del error cuadrático medio (RMSE) 

La raíz del error cuadrático medio permite cuantificar la magnitud de la desviación de los 

valores simulados respecto a los observados, la ecuación se recoge en el cuadro 6. En 

general cuanto mejor el ajuste más pequeño es el error. 

 

Cuadro 6. Índices de ajuste para la calibración del modelo hidrológico. En las ecuaciones, Sobs, sim, es la 

covarianza entre los caudales observados (Qi) y simulados (Qsim,i); Sobs, y Ssim son las varianzas de los 

caudales observados y simulados. Qmax es la descarga máxima observada. 

Índice de ajuste Ecuación 
N° de 

ecuación 
Rango de 
variación 

Valor 
Óptimo 

Coeficiente de 
calibración (r) 

 

� = �234,46"7�234�46" 12 0 ≤ � ≤ 1 1 

Criterio de Schultz (D) 
 

 

: = 200∑ �=6�* >46",6–>6�>6@�>"#$�A  

 

13 0 ≤ : ≤ ∞ 0 

Desviación media 
acumulada (MAD) C
: = ∑ D>46",6– >6D=6�* @  14 0 ≤ C
: ≤ 1 0 

Eficiencia de Nash-
Sutcliffe (E) 

 
� = 1 − ∑ �=6�* >46",6– >6�A∑ �	=6�* >6–>E�A  15 −∞ ≤ � ≤ 1 1 

Error de balance de 
masas (m) 

 
0 = 100∑ �=6�* >46",6–>6�∑ >6=6�*  16 0 ≤ 0 ≤ 1 0 

Raíz del error 
cuadrático medio 

(RMSE) 
 

C�� = F∑ �>46",6 − >6�A=6G* @  17 
0 ≤ C��≤ ∞ 

0 

 

Para evaluar el ajuste entre los datos  de caudales observados y los simulados, se utilizó el coeficiente 

de regresión lineal “R2”, cuyo rango de variación va de 0 a 1, donde el valor óptimo es cercano a 1. Los 

datos de caudales utilizados para el ajuste pertenecen a aforos realizados en la estación hidrológica 

“Puente Sajama” correspondientes a un año hidrológico del periodo de julio 2012 a septiembre 2013 

(Anexo 2). 
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Una vez evaluado el ajuste, la calibración fue realizada utilizando el método de optimización sucesiva, 

es decir, los valores de los parámetros del modelo hidrológico semidistribuido fueron cambiados 

siguiendo un análisis de prueba y error, hasta que se alcanzaron buenas respuestas del modelo 

(comparaciones de caudal modelado con caudal medido). Para este fin los parámetros usados fueron 

el coeficiente de escorrentía y la capacidad de almacenamiento de agua en el suelo, que varían en 

función a la textura del suelo por zona. Los datos de caudales medios usados en la calibración del 

modelo fueron los mismos usados en el ajuste de datos de caudales modelados con caudales medidos 

en campo. En el cuadro 7, se presentan los parámetros finales del modelo, ajustados como resultado 

del proceso de calibración de la modelación de la cuenca del río Sajama. En este proceso se estableció 

la sensibilidad del modelo a la variación de los parámetros, así como se identificaron los parámetros 

que tienen mayor influencia en los diferentes componentes del escurrimiento. 

Cuadro 7. Valores usados y calibrados de los parámetros del modelo hidrológico semidistribuido en la 

modelación de la cuenca del río Sajama. 

ZONAS 
Estaciones Tmax (mm) 

Coeficiente de 
escorrentía Área (m

2
) 

Caudal base 

nombre COD Saturación (%) mm/m
2
 B m

3
/s mm/mes*m

2
 

Nevados Chungara 1 4,3 43 0,200 58512891,29 0,17 7,5 

Alta Chungara 2 4,3 43 0,800 236576237,41 0,17 1,9 

Media Comisario 3 6,0 60 0,800 94326982,83 0,30 8,2 

Baja Sajama 4 21,9 219 0,800 167945733,95 0,30 4,6 

 

3 RESULTADOS 

La precipitaciones mensuales y la evapotranspiración potencial mensual fueron incorporados al 

modelo de balance de humedad del suelo para generar caudales mensuales del periodo Julio de 2012 

a Mayo de 2013. Los cálculos fueron puestos a prueba con los caudales observados en campo. Como 

se puede observar en la figura 5, el ajuste visual obtenido entre el caudal observado y el caudal 

calculado esta en un rango aceptable.  

 

 

 

 

 

 

 



 

 

ESTUDIO DE RELACIONES PRECIPITACIÓN-ESCURRIMIENTO Y DE POTENCIALES EFECTOS DEL CAMBIO CLIMÁTICO EN LA OFERTA DE 
AGUA DE LA CUENCA DE LOS RÍOS SURURÍA, MILLUNI Y RÍO SAJAMA (CARIPE-MILLUNI), EN EL PARQUE NACIONAL SAJAMA-BOLIVIA 

MODELO HIDROLÓGICO SEMIDISTRIBUIDO 
2013 

15 

Figura 5. Ajuste del caudal observado en campo y el caudal calculado mediante el modelo 

 

Los parámetros finales ajustados presentados anteriormente, permitieron establecer los parámetros 

de control de ajuste en la calibración del modelo mediante el ajuste de correlación lineal. Se obtuvo 

un ajuste con rango aceptable de 0,74 para la calibración del modelado de la cuenca del río Sajama 

como se muestra en la figura 6. Dicho valor es considerado como aceptable tomando en cuenta la 

limitación en la cantidad de datos de caudal medidos. 

Figura 6. Resultado del análisis de comparación de hidrogramas medidos y modelados, en la etapa de 

calibración, mediante el coeficiente de correlación “R2”. 

 

Una vez calibrados los parámetros del modelo hidrológico para el modelado de la cuenca del río 

Sajama, se procedió a simular datos de caudales desde septiembre de 2005 a marzo de 2013, donde 
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no existen caudales medidos y considerando al mes de septiembre la época de estiaje durante la cual 

la capacidad de almacenamiento de agua Tmax se acerca a cero. Entre los periodos mencionados se 

encontró que las mayores crecidas de caudales corresponden generalmente a los meses diciembre y 

enero. En la figura 7, se presentan dos eventos extremos. El primero, en el mes de diciembre de 2007 

con 5,39 m3/s, coincide con el mes de mayor precipitación del mismo año, con 203mm/mes. El 

segundo  evento corresponde al mes de enero de 2011 con 6,32 m3/s y 182mm/mes de precipitación. 

Figura 7. Análisis de hidrograma modelado y precipitación del periodo septiembre de 2005 a marzo 

de 2013. 

 

4 CONCLUSIONES  

El modelo hidrológico semidistribuido de balance de humedad del suelo tuvo resultados aceptables 

en la modelación de la cuenca del río Sajama. Ya que se obtuvo un coeficiente de correlación R2 de 

0,74 siendo este resultado considerado como bueno en la escala de evaluación del modelo 

hidrológico. 

El buen desempeño de un modelo hidrológico está condicionado a la calidad de los datos requeridos 

de entrada (precipitación y evapotranspiración potencial); éste es el principal problema en los 

modelos semiditribuidos y distribuidos. Un buen conocimiento de los procesos de modelación, 

control de calidad de los datos y calibración de los parámetros (coeficiente de escurrimiento, 

capacidad de almacenamiento del suelo y coeficiente de recesión), puede ayudar a resolver esta 

limitación. 
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6 ANEXOS 

Anexo 1. Datos de variables climáticas consistentes, completadas y extendidas. 

PRECIPITACIÓN (mm/mes) ETO (mm/mes) - 20% 

periodo Chungará Comisario Sajama Chungará Comisario Sajama 

ene-05 105,70 96,048 75,50 89,630 93,215 99,434 

feb-05 152,80 138,847 149,00 73,450 86,042 91,783 

mar-05 55,90 50,796 27,75 92,490 87,141 92,955 

abr-05 23,20 21,082 0,00 80,231 77,452 82,620 

may-05 0,00 0,000 0,00 76,309 69,356 73,984 

jun-05 0,00 0,000 0,00 72,673 60,901 64,965 

jul-05 4,50 4,089 0,00 71,432 59,786 63,775 

ago-05 0,00 0,000 0,00 87,382 71,258 76,013 

sep-05 5,50 4,998 0,50 78,470 80,874 86,270 

oct-05 0,00 0,000 1,50 101,458 98,404 104,970 

nov-05 12,00 10,904 14,00 103,004 110,407 117,774 

dic-05 59,40 53,976 53,50 100,430 113,395 120,961 

ene-06 161,50 146,753 206,75 85,319 102,519 109,359 

feb-06 98,40 89,415 99,50 78,948 82,485 87,989 

mar-06 44,03 40,012 38,99 86,749 87,255 93,076 

abr-06 30,50 27,715 25,95 83,486 78,817 84,075 

may-06 0,00 0,000 0,00 73,947 70,204 74,888 

jun-06 0,00 0,000 0,00 70,253 62,894 67,091 

jul-06 0,00 0,000 0,00 77,527 65,189 69,539 

ago-06 0,00 0,000 0,00 83,813 72,715 77,567 

sep-06 0,00 0,000  88,190 84,779 90,436 

oct-06 5,00 4,543 4,75 104,096 100,357 107,053 
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nov-06 29,70 26,988 19,25 102,487 106,491 113,596 

dic-06 41,50 37,710 29,00 109,582 108,719 115,973 

ene-07 108,00 98,138 84,75 94,687 98,677 105,261 

feb-07 51,30 46,616 31,25 84,591 83,365 88,927 

mar-07 64,10 58,247 95,00 81,194 87,156 92,971 

abr-07 9,00 8,178 15,00 83,570 78,309 83,534 

may-07 0,00 0,000 1,25 69,424 62,943 67,143 

jun-07 0,00 0,000 0,50 73,059 60,088 64,098 

jul-07 0,00 0,000 0,00 70,813 67,280 71,769 

ago-07 0,00 0,000 0,00 79,367 69,629 74,275 

sep-07 0,00 0,000 0,00 88,341 83,822 89,415 

oct-07 7,50 6,815 3,80 104,018 99,445 106,080 

nov-07 29,50 26,806 13,50 88,319 107,271 114,428 

dic-07 30,50 27,715 16,75 105,819 105,924 112,991 

ene-08 203,00 184,463 142,00 78,575 94,787 101,112 

feb-08 13,00 11,813 39,75 87,565 83,393 88,957 

mar-08 44,50 40,437 38,50 89,982 83,758 89,347 

abr-08 0,00 0,000 0,00 85,418 78,982 84,252 

may-08 0,00 0,000 0,00 74,456 69,252 73,873 

jun-08 0,00 0,000 0,00 69,653 64,702 69,019 

jul-08 0,00 0,000 0,00 76,596 61,363 65,457 

ago-08 0,00 0,000 5,25 86,126 70,080 74,756 

sep-08 2,36 2,144 0,00 94,061 82,959 88,495 

oct-08 6,06 5,507 3,75 102,850 100,052 106,727 

nov-08 0,00 0,000 0,00 111,650 105,541 112,582 

dic-08 95,00 86,325 98,50 99,271 106,245 113,333 

ene-09 38,50 34,984 27,50 100,938 100,749 107,471 

feb-09 122,50 111,314 85,75 78,353 82,798 88,323 

mar-09 59,50 54,067 62,25 88,595 92,624 98,804 

abr-09 21,50 19,537 13,00 81,370 80,606 85,984 

may-09 0,00 0,000 0,00 76,374 70,035 74,708 

jun-09 0,00 0,000 0,00 72,506 60,194 64,210 

jul-09 0,00 0,000 0,00 66,642 61,072 65,147 

ago-09 0,00 0,000 0,00 86,355 71,334 76,093 

sep-09 25,00 22,717 0,00 88,369 83,248 88,802 

oct-09 33,00 29,987 5,75 108,288 100,696 107,415 

nov-09 48,00 43,617 16,75 103,298 107,882 115,081 

dic-09 36,00 32,713 25,00 103,367 108,354 115,583 

ene-10 57,70 52,431 60,25 98,018 115,551 123,260 

feb-10 72,80 66,152 60,50 84,110 108,508 115,747 

mar-10 16,80 15,266 29,00 94,501 94,481 100,785 

abr-10 5,70 5,180 11,25 86,839 100,187 106,872 

may-10 6,30 5,725 3,75 72,491 96,930 103,397 

jun-10 0,00 0,000 0,00 71,778 78,610 83,855 

jul-10 2,00 1,817 0,00 76,925 95,422 101,789 

ago-10 1,00 0,909 0,00 91,598 103,682 110,600 

sep-10 0,00 0,000 0,00 92,613 128,114 136,662 

oct-10 0,80 0,727 1,75 103,401 149,426 159,396 

nov-10 0,10 0,091 0,50 117,923 100,487 107,192 

dic-10 52,00 47,252 61,25 103,367 131,977 140,782 

ene-11 86,70 78,783 73,25 94,435 131,378 140,144 
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feb-11 182,00 165,381 129,50 68,145 97,947 104,483 

mar-11 23,40 21,263 36,25 84,641 99,399 106,031 

abr-11 32,10 29,169 15,75 85,319 94,060 100,336 

may-11 13,20 11,995 11,25 73,738 83,481 89,051 

jun-11 0,40 0,363 0,00 68,468 81,614 87,059 

jul-11 8,10 7,360 4,37 73,323 91,380 97,477 

ago-11 0,00 0,000 0,00 85,773 100,990 107,729 

sep-11 0,10 0,091 0,00 88,341 98,980 105,584 

oct-11 0,10 0,091 0,00 104,018 129,903 138,570 

nov-11 7,80 13,200 4,08 103,813 120,069 142,763 

dic-11 120,70 135,200 112,85 103,799 126,261 143,737 

ene-12 168,82 153,400 159,21 97,933 102,846 110,218 

feb-12 100,58 91,400 93,47 77,717 79,638 84,921 

mar-12 44,03 40,012 38,99 86,969 90,259 96,498 

abr-12 17,43 15,837 13,36 81,568 84,059 89,740 

may-12 2,79 2,531 0,00 73,329 74,600 79,430 

jun-12 0,00 0,000 0,00 71,002 71,929 76,519 

jul-12 0,00 0,000 0,00 89,746 93,448 99,974 

ago-12 0,22 0,200 0,00 92,994 97,177 104,038 

sep-12 0,22 0,20 0,00 98,204 103,158 110,558 

oct-12 5,72 5,20 2,08 102,715 108,336 116,202 

nov-12 0,00 0,00 0,00 101,631 107,092 114,846 

dic-12 128,32 116,60 120,19 98,080 103,014 110,402 

ene-13 170,80 155,20 161,11 95,178 99,683 106,771 

feb-13 56,79 51,60 51,28 89,423 93,077 99,570 

mar-13 22,45 20,40 18,20 99,68 104,85 112,406 

abr-13 0,00 0,00 0,00 81,52 84,00 89,681 

may-13 7,48 6,80 3,78 82,42 85,03 90,800 

PROM 32,60 29,94 28,33 87,65 91,05 97,41 

MAX 203,00 184,46 206,75 117,92 149,43 159,40 

MIN 0,00 0,00 0,00 66,64 59,79 63,77 

 

Anexo 2. Lista de caudales medidos en campo. 

Mes/año 
Caudal Observado  

(m3/s) 

jul-12 2,075 

ago-12 1,594 

sep-12 1,429 

oct-12 1,390 

nov-12 1,282 

dic-12 2,197 

ene-13 3,187 

feb-13 2,878 

mar-13 1,625 

abr-13 1,399 

may-13 1,700 
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jun-13 1,602 

jul-13 1,715 

ago-13 1,554 

sep-13 1,345 

 

 

Anexo 2. Lista de caudales medidos y caudales modelados. 

Suma de 
caudales de las 

cuatro zonas 

Caudal Medido 
en campo 

QT  (m
3
/s) Qm(m

3
/s) 

1,16 2,07 

1,22 1,59 

1,18 1,43 

1,33 1,39 

1,80 1,28 

2,05 2,20 

3,34 3,19 

2,93 2,88 

1,46 1,62 

1,44 1,40 

1,10 1,70 

 

 

 

 

 

 


